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1. Introduction 
 

1.1 Add-on Module RF-LAMINATE 

The add-on module RF-LAMINATE from Dlubal Software calculates deformations and stresses 
of laminate surfaces. For example, you can use RF-LAMINATE to design cross laminated timber, 
glued-laminated timber or OSB boards. The module is well suitable for more than just  timber 
structures because you can create various layer compositions with any materials that can be 
selected from the available material library. Of course, you can also create other materials, 
which can be added to the library. 

In RF-LAMINATE, you can create structures with different material models. Not only isotropic 
and orthotropic material models are available, but also user-defined models and hybrid mod-
els, which allow for a combination of isotropic and orthotropic materials in one composition. 
For orthotropic materials, individual layers can be rotated of angle β  and you can take into 
account different properties in a required direction. Furthermore in RF-LAMINATE, you can de-
cide whether or not you want to consider shear coupling of individual layers in the calculation. 

Thanks to its clear layout and intuitive module windows for entering data, the module facilitates 
your work. In this manual, all necessary information is provided for working with RF-LAMINATE, 
including typical examples. 

Like other modules, RF-LAMINATE is fully integrated into the RFEM program. However, it is not 
only an visual part of the program. Results from the module, including graphical representa-
tions, can be incorporated to the RFEM printout report. Therefore, the entire analysis can be 
easily and, above all, uniformly arranged and organized. The same structure of all Dlubal mod-
ules facilitates work with RF-LAMINATE as well. 

We wish you much success during your work with the main program RFEM and its add-on 
module RF-LAMINATE. 

Your DLUBAL team 
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1.2 RF-LAMINATE - Team 
The following people were involved in the development of RF-LAMINATE: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
Dipl.-Ing. (FH) Younes El Frem 

Ing. Pavel Bartoš 
 

Programming 
doc. Ing. Ivan Němec, CSc. 
Mgr. Petr Zajíček 

Ing. Lukáš Weis 
Mgr. Vítězslav Štembera, Ph.D. 

Cross-section and material libraries 
Ing. Jan Rybín, Ph.D.  

Design of a program, windows, dialog boxes and icons 
Dipl.-Ing. Georg Dlubal MgA. Robert Kolouch 

Program testing 
Mgr. Vítězslav Štembera, Ph.D. 
Ing. Iva Horčičková 

Dipl.-Ing. (FH) Bastian Kuhn 
 

Manual, help system and translation 
Ing. Iva Horčičková 
Mgr. Vítězslav Štembera, Ph.D. 
Mgr. Ing. Hana Macková 
Mgr. Michaela Kryšková 

Dipl.-Ing. (FH) Bastian Kuhn 
Dipl.-Ing. (FH) Robert Vogl 
Dipl.-Ü. Gundel Pietzcker 

Technical support and quality management 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. (BA) Sandy Matula 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. (FH) Matthias Entenmann 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
M.Sc. Dipl.-Ing. (BA) Shaobin Ding 
Dipl.-Ing. (FH) Bastian Kuhn 
Dipl.-Ing. (FH) Andreas Hörold 
Dipl.-Ing. (FH) Stefan Frenzel 

Dipl.-Ing. (FH) Walter Fröhlich 
M.Sc. Dipl.-Ing. Frank Lobisch 
Dipl.-Ing. (FH) Alexander Meierhofer 
M. Eng. Dipl.-Ing. (BA) Andreas Niemeier 
M. Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (BA) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Robert Vogl 
Dipl.-Ing. (FH) Andreas Wopperer 

 

1.3 Using the Manual 
Topics such as operation system requirements or an installation procedure are described in 
detail in the manual for the main program RFEM, therefore we put them aside in this manual. 
On the contrary, we focus on RF-LAMINATE special features. 

When describing RF-LAMINATE, we keep to a sequence and structure of input and result win-
dows. The described icons (buttons) are introduced in the text in square brackets, for example 
[Details]. The buttons are also displayed on the left margin. Names of dialog boxes, windows 
and individual menus are marked in the text by using italics, in order to find them in the pro-
gram easily. 

An index for a quick search of certain terms is included in this manual too. If you still cannot 
find what you need, please check our Web site www.dlubal.com where you can browse FAQ 
pages and find suitable suggestions. 
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1.4 Starting RF-LAMINATE 

The add-on module RF-LAMINATE can be started from RFEM in several ways. 

Main menu 
You can start RF-LAMINATE by using the command from the RFEM main menu 

Add-on Modules → Others → RF-LAMINATE. 

 

Figure 1.1: Main menu: Add-on Modules → Others → RF-LAMINATE 

Navigator 
You can also start RF-LAMINATE from the Data navigator by clicking the item 

Add-on Modules → RF-LAMINATE – Design of laminate surfaces. 

 

Figure 1.2: Navigator Data: Add-on Modules → RF-LAMINATE 
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Panel 
If RF-LAMINATE results are already available in a certain RFEM model, you can set the relevant 
RF-LAMINATE design case in the load case list in the RFEM toolbar. By using the [Show Results] 
button, you can display deformations or stresses. 

The [RF-LAMINATE] button is now available in the panel; you can start RF-LAMINATE by using 
this button. 

 

Figure 1.3: Panel: Button [RF-LAMINATE] 
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2.  Theory 
Theoretical principles that are required for working with RF-LAMINATE are introduced in this 
chapter. 

2.1 Symbols 

t   Thickness of individual layers [m] 

β   Orthotropy direction [°] 

E   Young's modulus of elasticity [Pa] 

xE   Young's modulus of elasticity in x ′ -axis direction [Pa] 

yE   Young's modulus of elasticity in y ′ -axis direction [Pa] 

G   Shear modulus [Pa] 

xyG   Shear moduli in x y′ ′ -plane [Pa] 

xzG   Shear modulus in x z′ -plane [Pa] 

yzG   Shear modulus in y z′ -plane [Pa] 

ν   Poisson's ratio [-] 

ν ν,xy yx   Poisson's ratios in x y′ ′ ‘-plane [-] 

γ   Specific weight [N/m3] 

Tα   Coefficient of thermal expansion [1/K] 

ijd′   Elements of partial stiffness matrix in coordinate system , ,x y z′ ′  [Pa] 

ijd   Elements of partial stiffness matrix in coordinate system , ,x y z  [Pa] 

ijD   Elements of global stiffness matrix [Nm, Nm/m, N/m] 

,x yσ σ   Normal stresses [Pa] 

, ,yz xz xyτ τ τ  Shear stresses [Pa] 

n   Number of layers [-] 

z   z-axis coordinate [m] 

xm   Bending moment inducing stresses in x -axis direction [Nm/m] 

ym   Bending moment inducing stresses in y -axis direction [Nm/m] 

xym   Torsional moment [Nm/m] 

,x yv v   Shear forces [N/m] 

xn   Axial force in x -axis direction [N/m] 

yn   Axial force in y -axis direction [N/m] 

xyn   Shear flow [N/m] 

b,kf   Characteristic value of strength for bending [Pa] 

t,kf   Characteristic value of strength for tension [Pa] 

c,kf   Characteristic value of strength for compression [Pa] 

b,0,kf   Characteristic value of strength for bending along grain [Pa] 
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t,0,kf   Characteristic value of strength for tension along grain [Pa] 

c,0,kf   Characteristic value of strength for compression along grain [Pa] 

b,90,kf   Characteristic value of strength for bending perpendicular to grain [Pa] 

t,90,kf   Characteristic value of strength for tension perpendicular to grain [Pa] 

c,90,kf   Characteristic value of strength for compression perpendicular to grain [Pa] 

eqv,kf   Characteristic value of equivalent strength [Pa] 

xy,kf   Characteristic value of shear strength in plate plane [Pa] 

v,kf   Characteristic value of shear strength [Pa] 

R,kf   Characteristic value of rolling shear strength [Pa] 

b,df   Design value of strength for bending [Pa] 

t,df   Design value of strength for tension [Pa] 

c,df   Design value of strength for compression [Pa] 

b,0,df   Design value of strength for bending along grain [Pa] 

t,0,df   Design value of strength for tension along grain [Pa] 

c,0,df   Design value of strength for compression along grain [Pa] 

b,90,df   Design value of strength for bending perpendicular to grain [Pa] 

t,90,df   Design value of strength for tension perpendicular to grain [Pa] 

c,90,df   Design value of strength for compression perpendicular to grain [Pa] 

eqv,df   Design value of equivalent strength [Pa] 

xy,df   Design value of shear strength in plate plane [Pa] 

v,df   Design value of shear strength [Pa] 

R,df   Design value of rolling shear strength [Pa] 
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2.2 Material Models 

As already mentioned in the introduction, you can create individual layers of a structure from 
any material and from different material models in RF-LAMINATE. The following material mod-
els are available: 

• Orthotropic 

• Isotropic 

• User-Defined 

• Hybrid 

2.2.1 Orthotropic 
Properties of an orthotropic material are distinct in different directions. Therefore, the material 
is defined by using two moduli of elasticity xE  and ,yE  three shear moduli ,  yz xzG G  and ,xyG  
two Poisson's ratios ν xy  and ν ,yx  specific weight γ  and coefficient of thermal expansion T .α  

 
Figure 2.1: Orthotropic material model 

The moduli of elasticity and Poisson's ratios are in the following mutual relation 

ν ν
=yx xy

y xE E
  (2.1) 

Examples of the orthotropic material are timber or rolled metal sheets. 

Please note that when defining an orthotropic material, there are theoretically two ways how 
to define Poisson's ratios. The way used in RFEM is described by using Equation (2.1) and is 
characterized by the relation 

ν ν>xy yx   (2.2) 

in case that the grain runs in 'x -direction, that is x yE E> . In literature, you can also find the 
second way of the definition rarely, given by the equation / /yx x xy yE Eν ν= , leading to the in-
equality xy yxν ν< . If you take the orthotropic material properties from a certain document, 
you can easily find out the applied orthotropy definition from the inequality between both 
Poisson's ratios. 

In practice, material parameters are taken from standards. Let us show that on the example of 
softwood timber of strength class C24, whose values are given in standard EN 338, in Table 1. 

=

=

=

2
0,mean

2
90,mean

2
mean

11000 N/mm

370 N/mm

690 N/mm

E

E

G

  (2.3) 

It is assumed by default that the grain runs in 'x -direction. In this case the values have the fol-
lowing meaning 
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E E

E E

G G G

G
G

=

=

= =

=

  (2.4) 
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where yzG  is the shear modulus corresponding to the rolling shear stress. To find out the Pois-
son's ratios, it is convenient sometimes to use approximate Huber's formulas (see Huber [4]) 

ν

ν

 
 ≈ −
 
 
 
 ≈ −
 
 

1
2

1
2

x y x
xy

xy y

x y y
yx

xy x

E E E

G E

E E E

G E
  

(2.5)

 

For the softwood mentioned above you get 

ν

ν

=
=

= =

=

 ⋅
≈ −  ⋅ 
 ⋅

≈ −  ⋅ 





11000 MPa

370 MPa

690 MPa

69 MPa

11000 370 11000
1 2.52

2 690 370

11000 370 370
1 0.08

2 690 11000

x

y

xy xz

yz

xy

yx

E

E

G G

G
 (2.6) 

Now, let us introduce an example that illustrates the meaning of Poisson's ratios in the case of 
an orthotropic material. 

Example: 

Consider the plane stress of a plane plate with the dimensions 1 1 m.×   

 
Figure 2.2: Plane stress of the plate in x-direction and y-direction 

In the case of the plane stress condition for an orthotropic homogenous material, Hooke's law 
takes the form 

ν

ε σ
ν

ε σ
γ τ

 
− 

    
    

= −    
    
    
 
  

1
0

1
0

0 0

xy

x x
x x

yx
y y

y y
xy xy

xy

E E

E E

G

 (2.7) 



2  Theory 
 

 12 
 

Program RF-LAMINATE © 2013 Dlubal Software GmbH 

 

Furthermore, consider stress conditions without the shear stress 0.xyτ =  Relation (2.7) then 
implies that 0xyγ =  and it can be simplified to the form 

ν
ε σ
ε ν σ

 
− 

       =          − 
  

1

1

xy

x x x x

y yx y

y y

E E

E E

 (2.8) 

At first, consider the stress in x -direction, where the stress is given by the relation 
0,  0.x yσ σ≠ =  By the substitution to Equation (2.8), you get 

σε

ν
ε σ

=

= −

x
x

x

xy
y x

x

E

E

  (2.9) 

By using the combination of Equations (2.9) and (2.1), you get the relation for the Poisson's ra-
tio ν xy  

ε
ν

ε
= − y

xy
x

  (2.10) 

You proceed accordingly in case of the stress in y -direction, where the stress is given by the 
relation 0,  0.x yσ σ= ≠  By the substitution to Equation (2.8), you get 

ν
ε σ

σ
ε

= −

=

yx
x y

y

y
y

y

E

E

  (2.11) 

By using the combination of Equations (2.11) and (2.1), you get the relation for the Poisson's 
ratio ν yx  

εν
ε

= − x
yx

y

  (2.12) 

 

 

 

The case of the combined stress can be described by Equation (2.8) that can be converted to 
the following schematic form: 

σ
ε ν

σε ν

 
 −      =    −      
  

1

1

x

xx yx

yy xy

y

E

E

 (2.13) 

Equations (2.10) and (2.12) can be interpreted in the following way: the Poisson's ratio ν ij  

is equal to the negative contraction ratio in direction j  at the extension in direction .i  



2  Theory 

  

 13 Program RF-LAMINATE © 2013 Dlubal Software GmbH 

 

 

2.2.2 Isotropic 
An isotropic material has all mechanical properties the same in all directions. The material is 
defined by using the modulus of elasticity ,E  shear modulus ,G  Poisson's ratio ν ,  specific 
weight γ  and coefficient of thermal expansion T .α  

 
Figure 2.2: Isotropic material model 

Examples of the isotropic material are glass or steel. For the modulus of elasticity ,E  shear 
modulus G  and Poisson's ratio ν  the following relation applies 

( )ν
=

+2 1

E
G   (2.14) 

The value of the Poisson's ratio value is in the range −0.999,0.5 , where the limit value ν = 0.5  
corresponds to a voluminously incompressible material (in practice for example rubber). 

2.2.3 User-Defined 
A user-defined material model makes it possible to enter stiffness matrix elements of individu-
al layers directly. For the calculation of shear elements of the global stiffness matrix, you need 
to fill in shear moduli xzG  and .yzG  as well. The material is further characterized by the specific 
weight γ  and by the coefficient of thermal expansion T .α  

 
Figure 2.3: User-defined material model 

2.2.4 Hybrid 
A hybrid material model allows for a combination of isotropic and orthotropic layers. 

 
Figure 2.4: Hybrid material model 
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2.3 Stiffness Matrix 

2.3.1 Shear Coupling of Layers Is Considered 

Consider a plate consisting of n  layers of a generally orthotropic material. Each layer has the 
thickness it  and minimum and maximum z-coordinate ;min ;max, .i iz z  

 

  

 Layer No. 1 

 Layer No. 2 

 Layer No. 3 

  

 

Figure 2.5: Layer scheme 

The stiffness matrix for each layer is i′d  according to the following relation 

ν

ν ν

ν

 
 
 − −
 

′ ′   
   ′ ′= = =   
  − ′   

 
 
  

; ;;

; ;2 2
; ;

; ;
;11 ;12

;
;22

;2
;;33

;

;

0
1 1

0

0 0 1,...,
1sym.

sym.

i xy i yi x

i y i y
i xy i xy

i x i x
i i

i y
i i

i y
i xyi

i x

i xy

EE
E E

E E
d d

E
d i n

E
d

E

G

d  (2.15) 

 

For isotropic materials, where ; ;i x i yE E=  applies, the stiffness matrix has the simplified form 

ν
ν ν

ν

 
 − − ′ ′ 
  ′ ′= = =   −  ′   
 
 

2 2

;11 ;12

;22 2

;33

0
1 1

0

0 0 1,...,
1

sym.
sym.

i i i

i i
i i

i
i i

i
i

i

E E

d d
E

d i n

d
G

d     where 
( )ν

=
⋅ +2 1

i
i

i

E
G  (2.16) 

Because layers with orthotropic materials can be rotated arbitrarily by the angle β , it is neces-
sary to transform stiffness matrices of individual layers to a uniform coordinate system ,x y  
(local coordinate system of a surface). 

;11 ;12 ;13
T

;22 ;23 3×3; 3×3;

;33sym.

i i i

i i i i i i

i

d d d

d d

d

 
  ′= = 
  

d T d T  (2.17) 

where 

2 2

2 2
3×3;

2 2

,

2 2

i

c s cs

s c cs

cs cs c s

 
 
 = −
 
− −  

T  where ( )cos ic β= , ( )sin is β=  (2.18) 
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Bending and torsion 
Shear 
Membrane 
Eccentricity 

The individual elements then are 

4 2 2 4 2 2
;11 ;11 ;12 ;22 ;332 4i i i i id c d c s d s d c s d′ ′ ′ ′= + + +

2 2 4 4 2 2 2 2
;12 ;11 ;12 ;12 ;22 ;334i i i i i id c s d s d c d c s d c s d′ ′ ′ ′ ′= + + + −

3 3 3 3 3 3
;13 ;11 ;12 ;12 ;22 ;33 ;332 2i i i i i i id c sd cs d c sd cs d c sd cs d′ ′ ′ ′ ′ ′= + − − − +

4 2 2 4 2 2
;22 ;11 ;12 ;22 ;332 4i i i i id s d c s d c d c s d′ ′ ′ ′= + + +

3 3 3 3 3 3
;23 ;11 ;12 ;12 ;22 ;33 ;332 2i i i i i i id cs d c sd cs d c sd c sd cs d′ ′ ′ ′ ′ ′= + − − + −

( )22 2 2 2 2 2 2 2
;33 ;11 ;12 ;22 ;332i i i i id c s d c s d c s d c s d′ ′ ′ ′= − + + −  

The global stiffness matrix is 

11 12 13 16 17 18

22 23 27 28

33 38

44 45

55

66 67 68

77 78

88

0 0

0 0 sym.

0 0 sym. sym.

0 0 0

0 0 0

sym.

D D D D D D

D D D D

D D

D D

D

D D D

D D

D

 
 
 
 
 
 =  
 
 
 
 
  

D  (2.19) 

 
 

11 12 13 16 17 18

22 23 27 28

33 38

44 45

55

66 67 68

77 78

88

0 0

0 0 sym.

0 0 sym. sym.

0 0 0

0 0 0

sym.

x
x

y
y

xy
xy

xzx

yzy

x x

y y

xy
xy

m D D D D D D
m D D D D
m D D

v D D

v D

D D Dn

D Dn

Dn

κ
κ

κ

γ

γ

ε

ε

γ


                   =   
   
   
   
   
      

















 


 (2.20) 

 
 
 
 
 
 

If angles iβ  are multiples of 90°, the global stiffness matrix has the simplified form 

11 12 16 17

22 27

33 38

44 45

55

66 67

77

88

0 0 0 0

0 0 0 sym. 0

0 0 0 0

0 0 0

0 0 0

sym. 0

0

D D D D

D D

D D

D D

D

D D

D

D

 
 
 
 
 
 =  
 
 
 
 
  

D  (2.21) 
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Stiffness matrix elements (bending and torsion) [Nm] 

3 3
;max ;min

11 ;11
1 3

n
i i

i
i

z z
D d

=

−
= ∑  

3 3
;max ;min

12 ;12
1 3

n
i i

i
i

z z
D d

=

−
= ∑  

3 3
;max ;min

13 ;13
1 3

n
i i

i
i

z z
D d

=

−
= ∑  

 
3 3
;max ;min

22 ;22
1 3

n
i i

i
i

z z
D d

=

−
= ∑  

3 3
;max ;min

23 ;23
1 3

n
i i

i
i

z z
D d

=

−
= ∑  

 
3 3
;max ;min

33 ;33
1 3

n
i i

i
i

z z
D d

=

−
= ∑  

Note: in case of the single layer plate of thickness t , the introduced relations lead to the famil-
iar relation 

3 3 3

3 3 31
;max ;min

; 1; 1; 1;
1

2
2 2 2              , 1,2,3

3 3 3 12

n
i i

ij i ij ij ij ij
i

t t t
z z t

D d d d d i j
=

=

     − −     −      = = = = =∑  

 
 
Stiffness matrix elements (eccentricity effects) [Nm/m] 

2 2
;max ;min

16 ;11
1 2

n
i i

i
i

z z
D d

=

−
= ∑  

2 2
;max ;min

17 ;12
1 2

n
i i

i
i

z z
D d

=

−
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2 2
;max ;min

18 ;13
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n
i i

i
i

z z
D d

=

−
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2 2
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n
i i

i
i

z z
D d

=

−
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2 2
;max ;min

28 ;23
1 2

n
i i

i
i

z z
D d

=

−
= ∑  

 
2 2
;max ;min

38 ;33
1 2

n
i i

i
i

z z
D d

=

−
= ∑  

 
Stiffness matrix elements (membrane) [N/m] 

66 ;11
1

n

i i
i

D t d
=

= ∑  67 ;12
1

n

i i
i

D t d
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Stiffness matrix elements (shear) [N/m] 

The exact calculation procedure for shear elements of the stiffness matrix is not introduced, 
but the following relations apply 

( );11 44 ;11
1

5 5
max max

6 6

n

i i i i
i i i

G t D G t
=

  ≤ ≤ 
 

∑  (2.22) 

( );22 55 ;22
1

5 5
max max

6 6

n

i i i i
i i i

G t D G t
=

  ≤ ≤ 
 

∑  (2.23) 

 
where 

;11 ;12 T
2×2; 2×2;

;22sym.
i i

i i i i
i

G G

G

 
′= = 

 
G T G T  (2.24) 

where 
0

0
xz

i
yz

G

G

 
′ =  

 
G and 

( ) ( )
( ) ( )2×2;

cos sin

sin cos
i i

i
i i

β β
β β

 
=  − 

T  (2.25) 

 



2  Theory 

  

 17 Program RF-LAMINATE © 2013 Dlubal Software GmbH 

 

 

The individual elements then are 

2 2
;11 ; ;i i xz i yzG c G s G= +  

;12 ; ;i i xz i yzG csG csG= −  

2 2
;22 ; ; ,i i xz i yzG s G c G= +  where ( ) ( )cos , sini ic sβ β= =  

 

2.3.2 Shear Coupling of Layers Is Not Considered 

Now consider a plate consisting of n  isotropic material layers, where the individual layers are 
not shear coupled. Each layer has the thickness it  and minimum and maximum z-coordinate 

;min ;max, .i iz z  

 

  

 Layer No. 1 

 Layer No. 2 

 Layer No. 3 

  

 

Figure 2.6: Layer scheme 

The stiffness matrix for each layer is i′d  according to the following relation 
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For isotropic materials, where ; ;i x i yE E=  applies, the stiffness matrix has the simplified form 
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Bending and torsion 
Shear 
Membrane 

Because layers with orthotropic materials can be rotated arbitrarily by the angle ,β  it is neces-
sary to transform stiffness matrices of individual layers to a uniform coordinate system ,x y  
(local coordinate system of a surface). 

;11 ;12 ;13
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;22 ;23 3×3; 3×3;

;33sym.
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T where ( ) ( )cos , sini ic sβ β= =  (2.29) 

 

The individual elements then are 
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The global stiffness matrix is 
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If angles iβ  are multiples of 90°, the global stiffness matrix has the simplified form 
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Stiffness matrix elements (bending and torsion) [Nm] 
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Stiffness matrix elements (shear) [N/m] 
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The individual elements then are 

2 2
;11 ; ;i i xz i yzG c G s G= +  

;12 ; ;i i xz i yzG csG csG= −  

2 2
;22 ; ;i i xz i yzG s G c G= + , where ( )cos ic β= , ( )sin is β=  
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3. Input Data 
Input data of a structure is entered in windows, where calculation results are displayed as well. 

After you start RF-LAMINATE, a new window opens and on the left side a navigator is dis-
played, which contains all currently accessible windows. 

The windows can be opened either by clicking their names in the RF-LAMINATE navigator, or 
you can browse through them by using the [<] and [>] buttons, displayed here on the left, or 
also by the keys [F2] and [F3]. 

By using the [Calculation] button, you can run the calculation after all input data is entered. 

When you click the [Details...] button, dialog box appears where you can set the limit defor-
mation, plate bending theory and other calculation parameters (see Chapter 4.1, page 33). 

By clicking the [Graphics] button, you can display the RFEM workspace. 

When you click the [OK] button, the entered data is saved and RF-LAMINATE is closed, whereas 
by clicking the [Cancel] button, you quit the module without saving any changes. 

3.1 General Data 

In Window 1.1 General Data, you select the surfaces and loads for the design. You can specify 
load cases, load combinations or result combinations for the ultimate limit state design and for 
the serviceability limit state design separately in the corresponding tabs. 

Design of 
To select surfaces that you want to design, there is a text box where you can enter numbers of 
individual surfaces. The All check box facilitates this selection. By the [Select Surfaces] button, 
you can select the surfaces graphically in the RFEM work window. You can quickly delete the 
list of preset surface numbers by using the [Delete Current List of Surfaces] button or select all 
the text by double-clicking in the text box and rewrite it manually. 

Material Model 
In this section, you select the material model. The following material models are available: 

• Orthotropic 
• Isotropic 
• User-Defined 
• Hybrid 

For more information about material models see Chapter 2.2, page 10. 

Comment 
This text box is located in the bottom part of the window and you can quote your own notes 
or explanations for the current RF-LAMINATE case there. 
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3.1.1 Ultimate Limit State Tab 

 

Figure 3.1: Window 1.1 General Data – the Ultimate Limit State tab 

Existing Load Cases 
In this section, the list of all load cases, load combinations and result combinations, which 
were created in RFEM, is displayed. By using the [] button, you can add the selected load  
cases, load combinations or result combinations to the list on the right Selected for Design. You 
can also select individual items by double-clicking. By clicking the [] button, you add all 
items to the list on the right at once. 

You can also perform a multiple selection of load cases by using the [Ctrl] key, as usual in Win-
dows. In this way, you can select and add to the list on the right several load cases at the same 
time. 

In the bottom part of the section, you can use the buttons [Select All] and [Invert Selection], 
which facilitate the selection of requested load cases, load and result combinations together 
with the roll-out list. 

If load cases or load combinations are marked with an asterisk (*), as you can see for example 
in figure 3.1 at LC3, you cannot design them. In such a case, no loads were assigned to these 
load cases or load combinations or they contain only imperfections. 

Selected for Design 
The selected loads for the design are listed in the right column. By clicking the [] button, you 
can remove the selected load cases, load and result combinations from the list. Here, you can 
select items with a double-click as well. By clicking the [] button, you delete the entire list. 

In this section, you can also assign the design situation Persistent and Transient or Accidental to 
individual load cases, load and result combinations. The partial factors for material properties 
are assigned on the basis of this selection. The values of the partial factors can be modified for 
individual compositions in the Details of Composition dialog box. You can open this dialog box 
by clicking the [Edit Composition Details...] button in Window 1.2 or 1.3. 



3  Input Data 
 

 22 
 

Program RF-LAMINATE © 2013 Dlubal Software GmbH 

 

3.1.2 Serviceability Limit State Tab 

 

Figure 3.2: Window 1.1 General Data – the Serviceability Limit State tab 

Existing Load Cases 
In this section, the list of all load cases, load combinations or result combinations, which were 
created in RFEM, is displayed. After you add items to the list on the right Selected for Design, 
Window 1.5 Serviceability Data is displayed in the navigator. 

Selected for Design 
The addition of load cases, load and result combinations to the list for the design, and  their 
removal is carried out the same way like in the previous tab (see Chapter 3.1.1, page 21). 

In Selected for Design, the action combination is assigned to individual load cases, load and re-
sult combinations as well, either Characteristic, Frequent or Quasi-permanent. Different limit 
values for the deflection are applied on the basis of this selection. You can modify the limit 
values in the Details dialog box, in the Design tab. Open the Details dialog box by clicking the 
[Details...] button. 
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3.2 Material Characteristics 

 

Figure 3.3: Window 1.2 Material Characteristics 

In this window, you define layer compositions for individual surfaces of a structure. The select-
ed composition is displayed in the Current Composition section. You can specify individual lay-
ers for each composition. You can create more compositions with various layers here. For each 
composition, you need to define corresponding surfaces in the section List of Surfaces. 

The following buttons are available here: 

Button Name 

 Create New Composition 

 Edit Composition Details... 

 Copy Current Composition 

 Delete Current Composition 

 Delete All Compositions 

 Select Surfaces 

Table 3.1: Buttons in the window Material Characteristics 

For each composition, the dialog box Details of Composition is available. Open it by clicking the 
[Edit Composition Details...] button. Now, individual sections of the dialog box Details of Com-
position are described. 
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Figure 3.4: Dialog box Details of Composition 

Calculation Options 
In the section Calculation Options, the check box Consider coupling is selected by default, which 
means that the shear coupling of layers is considered. More information about both ap-
proaches is in Chapters 2.3.1 and 2.3.2. 

 
Figure 3.5: Basic stresses of the two-layer plate subjected to bending: with shear coupling of layers on the left, without 
shear coupling of layers on the right 

Below, the check box Cross laminated timber without glue at narrow sides is available. This op-
tion is suitable for plates from boards without side glue, when it is considered that 0.yE =  

Stiffness Reduction Factors 
In the section Stiffness Reduction Factors, you can reduce the torsional stiffness matrix element 

33D by using the factor 33.K  The correction is possible only for plates with the symmetric com-
position, for which the rotation angles are multiples of 90°. The correction is recommended in 
the standard ČSN 73 1702:2007, Chapter D.2.2 (5), page 127 (DIN 1052:2008, Chapter D.2.2 (5), 
page 175). 



3  Input Data 

  

 25 Program RF-LAMINATE © 2013 Dlubal Software GmbH 

 

 

 

 

Next, you can reduce shear stiffness matrix elements 44D  and 55D  by using reduction factors 

44K  and 55.K  The correction is possible only for plates, for which the rotation angles are mul-
tiples of 90°. 

The stiffness matrix is then equal to (the case of the symmetric composition is shown here) 
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 (2.35) 

In Window 1.2 Material Characteristics, you can display the modified stiffness matrix by clicking 
the [Show extended stiffness matrix elements] button. 

Partial Factors for Material Properties 
If you select the check box Partial factor Mγ  in Window 1.2, you can rewrite partial safety fac-
tors for material properties Mγ  for offered design situations in this section. The design situa-
tions are assigned to individual load cases, load and result combinations in Window 1.1 Gen-
eral Data, in the tab Ultimate Limit State (see Chapter 3.1.1, page 21). 

 

Figure 3.6: Window 1.2 Material Characteristics 

In Window 1.2 Material Characteristics, in the Layers section, you enter individual layers for the 
current composition. You can select the relevant material directly from the library, where a 
large number of materials with all the necessary parameters are already predefined. You can 
open the material library by clicking the [Import Material from Library...] button or you can 
place the pointer to the corresponding line in column A and click the [...] button. 
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Figure 3.7: Material library 

The material library is very extensive, therefore various filters are available. The offer of materi-
als can be reduced in the list by using the criteria Material category group, Material category, 
Standard group and Standard. In the material library, in the list Material to Select, you can 
choose the required material and then check its parameters in the lower part of the dialog box. 
When you click the [OK] button, press the [↵] key or double-click a material, you import the 
material to Window 1.2 Material Characteristics of RF-LAMINATE. Then it is possible to adjust all 
material parameters directly in the module. 

Furthermore, using the [Import Layers from Library...] button, you can enter the entire compo-
sition at once. There, you have the library of layers where you can select the Producer, Type and 
Thickness. 
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Figure 3.8: Dialog box Import Layers from Library 

If you select the orthotropic material model in Window 1.1 General Data, the orthotropy direc-
tion according to the currently entered β is displayed in the RFEM graphic when you enter in-
dividual layers in Window 1.2 Material Characteristics, see the following picture. In this way, you 
can check your settings visually. 

 

Figure 3.9: Display of the orthotropy direction β 

Below the Layers section, a number of useful buttons are available. The buttons have the fol-
lowing functions: 

Button Name Function 

 Load Saved Layers... Loads the composition that was saved before. 

 Save Layers As... 

Saves the entered composition from Window 1.2. 
This composition can be then reloaded to any oth-
er RF-LAMINATE composition by using the [Load 
Saved Layers...] button. 

 Delete All Layers Deletes all data from Window 1.2. 

 Import Material from Library... Opens the dialog box Material Library. 
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 Import Layers from Library... Opens the dialog box Import Layers from Library. 

  
Show layer stiffness matrix 
elements 

Displays elements of the stiffness matrix that is 
explained in Chapter 2.3. 

 
Show extended stiffness ma-
trix elements 

Displays elements of the global stiffness matrix 
that is explained in Chapter 2.3. 

 
Jump to graphic to change 
view 

Opens the RFEM work window for a graphical 
check, but does not quit the RF-LAMINATE module. 

 
Export to Microsoft Excel or 
OpenOffice.org Calc 

Exports the contents of the current table to MS 
Excel or to the Calc application from the OpenOf-
fice.org package  Chapter 7.2, page 58. 

 
Import from Microsoft Excel 
or OpenOffice.org Calc 

Imports the contents of a MS Excel table, the 1.2 
Material Characteristics sheet, or from the Calc 
application of the OpenOffice.org package to Win-
dow 1.2. 

Table 3.2: Buttons in the window Material Characteristics 

In Window 1.2 Material Characteristics, under the table on the right, Info is provided about the 
specific weight and weight of the current layer, and about the total thickness and total weight 
of the selected composition. 

Furthermore, in the Options section, there are check boxes to consider the partial factor Mγ  
and modification factor modk  for the design. You can set the values of the partial factors for 
each composition separately in the dialog box Details of Composition. The values of the modifi-
cation factors for all compositions are the same and you can edit them in the Details dialog 
box. If you select the check box Modification factor mod ,k  see figure 3.10, another Window 1.4 
Load Duration and Service Class is displayed in the navigator. 

 

Figure 3.10: Window 1.2 Material Characteristics – the modification factor kmod 
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3.3 Material Strengths 

 

Figure 3.11: Window 1.3 Material Strengths 

In Window 1.3, all characteristic strengths are displayed, imported for individual layers of a cur-
rent composition from the material library. You can change these values simply by editing the 
values in Window 1.3. 

Below the table, there are the same buttons as in the previous window, which are described in 
Chapter 3.2 on page 23. 

Again, under the table on the right, Info is provided about the specific weight and weight of 
the current layer, and about the total thickness and total weight of the selected composition. 
There are also check boxes to consider the partial factor Mγ  and the modification factor mod.k  
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3.4 Load Duration and Service Class 

 
Figure 3.12: Window 1.4 Load Duration and Service Class 

If you select the check box Modification factor modk  in Window 1.2 Material Characteristics or in 
Window 1.3 Material Strengths, Window 1.4 Load Duration and Service Class is displayed. Here, 
all load cases and combinations that were selected for the design in Window 1.1 are displayed. 
In columns A and B, Description and Loading Type as defined in RFEM are shown. In column C, 
the Load Duration Class - LDC is set, where the assignment to various classes follows the stand-
ard EN 1995-1-1:2006. The classification of load combinations and result combinations adhere 
to the governing load automatically. When you fill in column C, the corresponding factor modk  
is supplied automatically. You can preset its value in the Details dialog box under the Design 
tab. 

In the section Service Class , you can assign service classes to surfaces. The service classes are 
required for determination of the modification factor mod.k  The description of individual ser-
vice classes is provided directly in the window and is based on the standard EN 1995-1-1:2006, 
Chapter 2.3.1.3. 

The service class can be set the same for all surfaces, or you can select Different…. Then click 
the [Assign surface to corresponding service classes…] button and display the dialog box 
where you can assign individual surfaces to different service classes. 
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Figure 3.13: Dialog box Assign Surface to Corresponding Service Class 

In the dialog box Assign Surface to Corresponding Service Class, the following buttons are avail-
able: 

Button Function 

 
Performs the graphical selection of surfaces that will be assigned to a corre-
sponding service class. 

 Assigns all surfaces to a corresponding service class. 

 Assigns all surfaces that were not selected yet to a corresponding service class. 

Table 3.3: Buttons in the dialog box Assign Surface to Corresponding Service Class 
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3.5 Serviceability Data  

 

Figure 3.14: Window 1.5 Serviceability Data 

The last input window is 1.5 Serviceability Data. In column A, you can enter individual surfaces. 
In column B, choose whether you want to enter Reference Length L manually or not. If you do 
not select the Manual check box, the length of the longest boundary line of the relevant sur-
face is set automatically. In column D, select whether there is a Cantilever or not and it is possi-
ble to write your own Comment in column E. 

All entered data is important for the correct application of limit deformations. You can check 
and if necessary modify these values in the Details dialog box, in the Design tab (see Chapter 
4.1.1, page 34). 
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4. Calculation 
Before you start the calculation (by using the button with the same name), it is necessary to 
check the detailed settings for the design. Open the relevant dialog box, which is described in 
the following chapter, by clicking the [Details…] button. 

Before the calculation begins, it is checked whether the global stiffness matrix is positive-
definite, see 9.2. 
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The calculation then runs globally with the entire structure that was modeled in RFEM. 

 

4.1 Details  

For the reason of clarity, the Details dialog box is divided into the following tabs: 

• Design 

• Stresses 

• Results 

The following buttons are common for all the tabs: 

Button Name Function 

 Help (F1) Calls up the online help for RF-LAMINATE. 

 
Units and Decimal 
Places... 

Opens the dialog box Units and Decimal Places, where you 
can set units for RF-LAMINATE. 

 
Reset Dlubal Standard 
Values 

Sets all values in the Details dialog box to the original 
Dlubal values. 

 Default 
Sets all parameters in the Details dialog box according to 
the default setting that was saved previously. 

 Set As Default 
Saves the current setting as default. You can then reload 
this setting to any RF-LAMINATE case by using the previ-
ous button [Default]. 

Table 4.1: Buttons in the Details 
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4.1.1 Design Tab  

 

Figure 4.1: Dialog box Details – the Design tab 

Serviceability Limits (Deflections) 
The limit values of allowable deflections are set in six text boxes. In this way, you can enter 
specific data for various action combinations (characteristic, frequent and quasi-permanent) 
and for surfaces supported on both sides or one side only. The action combinations are as-
signed to load cases, load combinations and result combinations in the tab Serviceability Limit 
State in Window 1.1 General Data (see Chapter 3.1.2, page 22). Reference lengths L are entered 
for individual surfaces in Window 1.5 Serviceability Data (see Chapter 3.5, page 32). 

Modification Factor 
Values of the modification factor modk are provided there according to the Load Duration Class 
(LDC) and Service Class. The values follow the standard EN 1995-1-1:2006, Table 3.1. You can 
rewrite numeric values of the modification factor. The modification factor is then assigned to 
individual load cases according to the corresponding load duration class in Window 1.4 Load 
Duration and Service Class (see Chapter 3.4, page 30). 
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4.1.2 Stresses Tab  

 

Figure 4.2: Dialog box Details – the Stresses tab 

To Display 
In this section, you can choose which stresses you want to display in the result windows by us-
ing check boxes. The stresses are separated for middle layers and for top/bottom layers. The 
buttons [Select All] and [Deselect All] are available to facilitate the selection. 

Basic stresses , , , ,x y xy xz yzσ σ τ τ τ  are calculated by the finite element method in RFEM, other 
stresses are then calculated from these basic stresses in the RF-LAMINATE module. Formulas 
valid for a single layer plate are introduced in the following table. 

 

Figure 4.3: Basic stresses and the sign convention for the single layer plate subjected to bending 
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xσ  

Normal stress in x-direction 

• the stress on the positive surface side is 
equal to 

, 2

6
,x x

x
n m

t t
σ + = +  where t = plate thick-

ness 

• the stress on the negative surface side is 
equal to 

, 2

6x x
x

n m

t t
σ − = −  

yσ  

Normal stress in y-direction 

• the stress on the positive surface side is equal 
to 

, 2

6y y
y

n m

t t
σ + = +  

• the stress on the negative surface side is equal 
to 

, 2

6y y
y

n m

t t
σ − = −  

xyτ  

Shear stress in xy plane 

• the stress on the positive surface side is equal 
to 

, 2

6xy xy
xy

n m

t t
τ + = +  

• the stress on the negative surface side is equal 
to 

, 2

6xy xy
xy

n m

t t
τ − = −  

xzτ  

Shear stress in xz plane 

• in the plate center 
3

2
x

xz
v

t
τ =  

 

yzτ  

Shear stress in yz plane 

• in the plate center 

3

2
y

yz
v

t
τ =  

 
 

Table 4.2: Basic stresses 
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Generally, the stresses in individual layers are calculated from the total internal strains of the 
plate 

tot
T ,  ,  ,  ,  ,  ,  ,  y yx x

y x
w w u v u v

x y y x x y x y y x

ϕ ϕϕ ϕ ϕ ϕ
∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂

= − − + − + 
∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂ ∂ 

ε  (4.2) 

 

The strains in individual layers are calculated by using the relation 

( )

y

x
x

y

xy
y x

u

x x
v

z z
y y

u v

y x y x

ϕ

ε
ϕε

γ
ϕ ϕ

   ∂∂   
∂ ∂   

  ∂ ∂   = = + −     
∂ ∂     

     ∂ ∂ ∂ ∂+   −
∂ ∂ ∂ ∂    

ε  (4.3) 

where z is the coordinate in z -direction, where the stress value is requested. If there is for ex-
ample i − th layer, the stress is calculated by using the relation 

( ) ( )iz z=σ d ε   (4.4) 

where id  is the partial stiffness matrix of the i − th layer. 

Now, it is necessary to divide stresses according to the material model - isotropic or ortho-
tropic. 

Isotropic material model 

 

Figure 4.4: Dialog box Details – the Stresses tab for the isotropic material model 
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The effect of the transversal shear stresses is expressed by the quantity: 

maxτ  

Maximum transversal shear stress 
2 2

max yz xzτ τ τ= +  

Table 4.3: Maximum transversal shear stress 

The relations for the calculation of principal and equivalent stresses are introduced in the fol-
lowing table. The effect of the shear stresses is neglected in the formulas τ xz  and .yzτ  

Table 4.4: Stresses for the isotropic material model 

1σ  

Principal stress 

( )2 2

1

4

2

x y x y xyσ σ σ σ τ
σ

+ + − +
=  

2σ  

Principal stress 

( )2 2

2

4

2

x y x y xyσ σ σ σ τ
σ

+ − − +
=  

α  

The angle between the local axis x  and the direction of the first principal stress 

 
 
 
 
 
 
 
 

( )1
atan2 2 ,  ,    ( 90 ,90

2 xy x yα τ σ σ α= − ∈ −    

Function atan2  is implemented in RFEM this way 

( )

arctan 0

arctan 0, 0

arctan 0, 0
atan2 ,

0, 0
2

0, 0
2

0 0, 0

y
x

x
y

y x
x
y

y x
y x x

y x

y x

y x

π

π

π

π

 >

 + ≥ <

 − < <= 


+ > =



− < =


= =

 

eqvσ  

Equivalent stress according to von Mises, Huber, Hencky 
(Shape modification hypothesis) 

2 2 2
eqv 3x y x y xyσ σ σ σ σ τ= + − +  

Equivalent stress according to Tresca 
(Maximum shear stress criterion) 

( ) ( )2 2
2 2

eqv

4
max 4 ,  

2

x y x y xy
x y xy

σ σ σ σ τ
σ σ σ τ

 
+ + − + 

= − + 
 
 

 

Equivalent stress according to Rankine, Lamé 
(Maximum principal stress criterion) 

( )2 2

eqv

4

2

x y x y xyσ σ σ σ τ
σ

+ + − +
=  

Equivalent stress according to Bach, Navier, St. Venant, Poncelet 
(Principal strain criterion) 

( )ν νσ σ σ σ σ τ ν σ σ
 − +

= + − + + 
 

+ 2 2
eqv

1 1
max 4 ,  

2 2x y x y xy x y  
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Orthotropic material model 

 

Figure 4.5: Dialog box Details – the Stresses tab for the orthotropic material model 

 

b+t/c,0σ  

Normal stress along the grain 
2 2

b+t/c,0 cos sin2 sinx xy yσ σ β τ β σ β= + +

 
 
 
 
 

1 – grain direction 

b+t/c,90σ  
Normal stress perpendicular to the grain 

2 2
b+t/c,90 sin sin2 cosx xy yσ σ β τ β σ β= − +  

t/c,0σ  

Tension/compression component of the normal stress along the grain 

b+t/c,0(top) b+t/c,0(middle) b+t/c,0(bottom)
t/c,0 3

σ σ σ
σ

+ +
=  

t/c,90σ  

Tension/compression component of the normal stress perpendicular to the 
grain 

b+t/c,90(top) b+t/c,90(middle) b+t/c,90(bottom)
t/c,90 3

σ σ σ
σ

+ +
=  

b,0σ  Bending component of the normal stress along the grain 

b,0 b+t/c,0 t/c,0σ σ σ= −  

b,90σ  Bending component of the normal stress perpendicular to the grain 

b,90 b+t/c,90 t/c,90σ σ σ= −  
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Rτ  

Rolling shear stress 

R sin cosxz yzτ τ β τ β= − +  

 

 

 
Table 4.5: Stresses for the orthotropic material model 

It is important to realize that the stresses b+t/c,0 b+t/c,90 t/c,0 t/c,90 b,0 b,90 R,  ,  ,  ,  ,  ,  σ σ σ σ σ σ τ  are 

expressed in the coordinate system of the grain , ,x y z′ ′ , which can be rotated differently in 
every layer in general. That is why discontinuities in stress values of individual layers can occur 
at their boundaries. The transformation formulas for these stresses are introduced in Chapter 
5.1. 

The normal stress contains the bending component and the tension/compression  
component for individual layers. 

 

Figure 4.6: Decomposition of the normal stress into the tension/compression component and the bending component 

Plate Bending Theory 
For surfaces, you can choose the bending theory according to: 

• Mindlin 

• Kirchhoff 

The shear strain is considered for calculation according to the Mindlin theory, but not accord-
ing to the Kirchhoff theory. The bending theory according to Mindlin is suitable for massive 
plates, the bending theory according to Kirchhoff for relatively thin plates. 

Because the shear stresses xzτ  and yzτ  are not determined exactly in the Kirchhoff's theory, 
they are calculated from equilibrium conditions. You can calculate them by using the follow-
ing relations 

,max
3

= 1.5
2

x x
xz

v v

t t
τ =   (4.5) 

,max
3

= 1.5
2

y y
yz

v v

t t
τ =   (4.6) 
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Equivalent Stresses According to (for Isotropic Materials) 
You can determine the equivalent stresses in four different ways: 

Equivalent stress according to von Mises, Huber, Hencky 
(Shape modification hypothesis) 
This hypothesis is known as HMH, the VON MISES hypothesis, or as the energy criterion. The 
equivalent stress according to this hypothesis is calculated by using the relation 

2 2 2
eqv 3x y x y xyσ σ σ σ σ τ= + − +  (4.7) 

Equivalent stress according to Tresca 
(Maximum shear stress theory) 
This equivalent stress is generally defined by using the relation 

( )eqv 1 2 1 3 2 3max ,  ,  σ σ σ σ σ σ σ= − − −  (4.8) 

which is on the condition 3 0σ = , simplified to 

( )eqv 1 2 1 2max ,  ,  σ σ σ σ σ= −  (4.9) 

and the resulting equation 

( ) ( )2 2
2 2

eqv

4
max 4 ,  

2

x y x y xy
x y xy

σ σ σ σ τ
σ σ σ τ

 
+ + − + 

= − + 
 
 

 (4.10) 

Equivalent stress according to Rankine, Lamé 
(Maximum principal stress criterion) 
This hypothesis is known as the normal stress hypothesis or as the equivalent stress according 
to RANKINE. The Rankine's stress is generally defined as the maximum of absolute values of 
principal stresses 

( )eqv 1 2 3max ,  ,  σ σ σ σ=  (4.11) 

which is on the condition 3 0σ = , simplified to 

eqv 1 2max( ,  )σ σ σ=   (4.12) 

and the resulting equation 

( )2 2

eqv

4

2

x y x y xyσ σ σ σ τ
σ

+ + − +
=  (4.13) 

Equivalent stress according to Bach, Navier, St. Venant, Poncelet 
(Principal strain criterion) 
The principal deformation hypothesis or the equivalent stress according to BACH. The equiva-
lent strain is defined as the maximum strain that originates in the direction of principal stresses 

( ) ( ) ( )( )σ σ ν σ σ σ ν σ σ σ ν σ σ= − + − + − +eqv 1 2 3 2 1 3 3 1 2max ,  ,   (4.14) 

which is on the condition 3 0σ = , simplified to 

( )σ σ νσ σ νσ ν σ σ= − − +eqv 1 2 2 1 1 2max ,  ,   (4.15) 

and the resulting equation 

( )ν νσ σ σ σ σ τ ν σ σ
 − +

= + − + + 
 

+ 2 2
eqv

1 1
max 4 ,  

2 2x y x y xy x y  (4.16) 

In the formulas for the equivalent stress, influence of shear stresses τ xz  and .yzτ is neglected. 
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4.1.1 Results Tab  

 

Figure 4.7: Dialog box Details – the Results tab 

Display Result Tables 
In this section, you can specify which result windows you want to display. There are various 
windows with result values of stresses, displacements and parts lists, which you can switch on 
or off by using the relevant check boxes. 

Individual result windows are described in Chapter 5. Results on page 44. 

Results in 
Stresses and displacements are displayed in all FE mesh points by default. However, you have 
the option to display results in grid points that you have defined and that are saved in RFEM as 
a surface property (see the RFEM manual, Chapter 8.12). 

In the case of smaller surfaces, the default grid point spacing of 0.5 m can cause that only a 
small amount of points exists on a surface or even one point, the initial grid point. In such a 
case, you generally do not get any maximum values because the resulting grid is too coarse. 
The spacing of grid points then should be adapted to the surface dimensions in RFEM, in order 
to create more grid points. 

Internal Forces Diagram Used for Design 
In this section, you can select the check box Apply smoothed internal forces in the defined 
smooth ranges and thus use the smooth ranges that were specified in RFEM during the stress 
calculation in RF-LAMINATE. 
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4.2 Start Calculation  

In all RF-LAMINATE input windows, you can start the calculation by clicking the [Calculation] 
button. 

You can also start the RF-LAMINATE calculation from the RFEM user interface. Add-on modules 
are displayed in RFEM in the dialog box To Calculate, in the tab Load Cases / Combinations / 
Module Cases. You can open this dialog box in RFEM by using the command from the main 
menu 

Calculate → To Calculate…. 

 

Figure 4.8: Dialog box To Calculate in RFEM 

If an RF-LAMINATE design case is missing in the Not Calculated list, you have to select Add-on 
Modules in the bottom part of the dialog box. 

By using the [] button, add the selected design case to the list on the right. Then, start the 
calculation by using the [OK] button. 

You can also start the calculation of an RF-LAMINATE design case from the toolbar. You set the 
requested design case in the list and then click the [Show Results] button. 

 
Figure 4.9: Direct calculation of the RF-LAMINATE design case in RFEM 
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5. Results 
Window 2.1 Max Stress/Ratio by Loading is displayed immediately after the calculation ends. In 
the Details dialog box, in the Results tab, you can specify which result windows you want to 
display (see Chapter 4.1.1 on page 42). 

All result windows are accessible from the RF-LAMINATE navigator. To browse through indi-
vidual windows, you can use the [<] and [>] buttons, displayed here on the left margin, or the 
function keys [F2] and [F3]. 

By clicking the [OK] button, you save all input data and results and close  
RF-LAMINATE, whereas by clicking the [Cancel] button, you quit the module without saving 
the data. 

In the result windows, a number of useful buttons is available. The buttons have the following 
functions: 

Button Name Function 

 
Jump to graphic to change 
view 

Opens the RFEM work window for a graphical 
check, but does not quit the RF-LAMINATE module. 

 Select  
Opens the RFEM work window for a graphical se-
lection of surfaces or points. 

 
Show current results in RFEM 
graphic 

Displays results from the current line in the RFEM 
graphical window in the background. 

 Show rows with ratio > 1 
Displays only the rows with the design ratio >1 in 
tables. 

  Show color bars in table 
Displays the colored background in result tables 
according to the relation scale. 

 
Export to Microsoft Excel or 
OpenOffice.org Calc 

Exports contents of a current table to MS Excel or 
to the Calc application from the OpenOffice.org 
package  Chapter 7.2, page 58. 

Table 5.1: Buttons in result windows 

In this chapter, individual windows are described gradually according to their sequence. 
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5.1 Max Stress/Ratio by Loading 

 

Figure 5.1: Window 2.1 Max Stress/Ratio by Loading 

If the calculation proceeds successfully, Window 2.1 Max Stress/Ratio by Loading opens. In this 
window, maximum stress values or maximum ratios are displayed for each load case, load 
combination or result combination that you selected for the design in Window 1.1 General  
Data, in the tab Ultimate Limit State. The numbers of load cases, load and result combinations 
are shown in the heading of each section. 

Regarding the fact that compositions with layers from different materials are often designed in 
RF-LAMINATE, it can happen that the maximum ratio is found in a different location than the 
maximum stress value. For this reason, below the table you can choose whether you want to 
display the maximum stress ratios or maximum stress values in the table. 

Individual columns of Table 2.1 are described below. 

Surface No. 
This column contains the numbers of surfaces, for which maximum values of stress compo-
nents or ratios were found during the calculation. The data is shown for individual load cases. 

Point No. 
In this column, the numbers of FE mesh points are displayed, or of grid points, where the stress 
values or ratios reach the maximum. The grid points represent the option to display results in-
dependently of the FE mesh, in a regular spacing that you defined. Their count and arrange-
ment are set in the Grid tab in the dialog box Edit Surface in RFEM. 

In the Details dialog box, in the Results tab, you can specify whether you want to evaluate the 
results in FE mesh points or in grid points (see Chapter 4.1.1, page 42). 

Point Coordinates 
The displayed global coordinates X, Y, Z specify the point with the maximum value of the giv-
en stress or its ratio. 
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Layer 
In columns F - H, the layer number is listed, z –coordinate and side of the given layer, where 
maximum stress values or ratios occur. 

Stresses 

Symbol and Existing 

Here, the maximum stress values that you selected in the Stresses tab, the Details dialog box, 
are displayed. The symbol and the existing numeric value are shown. 

Limit 

The limit value (limit stress) results from the material selection for individual layers in Window 
1.2 Material Characteristics. 

If you use the modification factor modk or the partial factor Mγ , then the design stress values 
(with subscript d) are calculated from the characteristic limit stress values (with subscript k), 
according to 

γ

  
  
  
  
  
  
  
  
  
  =  
 
 
 
 
 
 
 
 
 
 

b,d b,k

t,d t,k

c,d c,k

b,0,d b,0,k

t,0,d t,0,k

c,0,d c,0,k
mod

b,90,d b,90,k

t,90,d t,90,k

c,90,d c,90,k

xy,d xy,k

v,d v,k

eqv,d eqv,k

R,d R,k

M

f f

f f

f f

f f

f f

f f
k

f f

f f

f f

f f

f f

f f

f f













 
 
 
 
 
 
 
 
 
 

  (5.1) 

If the modification factor and the partial factor are not used, it is considered that 

mod 1k = and 1.Mγ =  

Ratio 
The ratio of the design stress and limit stress is calculated for every stress component. The ratio 
of the surface in the corresponding FE mesh point or grid point is listed for each selected kind 
of stress. If the limit stress is not exceeded, the ratio is less than or equal to 1 and the stress de-
sign is satisfied. Thus the entry in column L allows you to quickly assess the efficiency of the 
design. 
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The following tables show the ratio calculation for particular kinds of stress. 

Isotropic material model 

Stresses [Pa] Ratios [-] 

xσ  

b,t/c,
t/c,

t,d b,d

t/c, b,
t/c,

c,d b,d

if 0 

if 0

xx
x

x x
x

f f

f f

σσ
σ

σ σ
σ


+ >

= 
 + ≤


 

yσ  

b,t/c,
t/c,

t,d b,d

t/c, b,
t/c,

c,d b,d

if 0 

if 0

yy
y

y y
y

f f

f f

σσ
σ

σ σ
σ


 + >


= 


+ ≤


 

1σ  

1
1

t,d

1
1

c,d

if 0 

if 0 

f

f

σ σ

σ
σ

 >
= 
 ≤

 

2σ  

2
2

t,d

2
2

c,d

if 0

if 0

f

f

σ σ

σ
σ

 >
= 
 ≤

 

eqvσ  eqv

eqv,df

σ
 

maxτ  max

v,df

τ
 

xzτ  
v,d

xz

f

τ
 

xyτ  
v,d

xy

f

τ
 

yzτ  
v,d

yz

f

τ
 

Table 5.2: Ratios for the isotropic material model 
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Orthotropic material model 

Stresses [Pa] Ratios [-]  

b,0σ  b,0

b,0,df

σ
 

 

b,90σ  b,90

b,90,df

σ
 

 

t/c,0σ  

t/c,0
t/c,0

t,0,d

t/c,0
t/c,0

c,0,d

if 0

if 0

f

f

σ
σ

σ
σ

 >
= 
 ≤


 

 

t/c,90σ  

t/c,90
t/c,90

t,90,d

t/c,90
t/c,90

c,90,d

if 0

if 0

f

f

σ
σ

σ
σ

 >
= 
 ≤


 

 

b+t/c,0σ  

b,0t/c,0
t/c,0

t,0,d b,0,d

t/c,0 b,0
t/c,0

c,0,d b,0,d

if 0

if 0

f f

f f

σσ
σ

σ σ
σ


+ >

= 
 + ≤


 

According to: 
ČSN 73 1702, (127), (128) 
DIN 1052, (127), (128) 
DIN EN 1995-1-1/NA, (NA.130), 
(NA.131) 

b+t/c,90σ  

b,90t/c,90
t/c,90

t,90,d b,90,d

t/c,90 b,90
t/c,90

c,90,d b,90,d

if 0

if 0

f f

f f

σσ
σ

σ σ
σ


+ >

= 
 + ≤


 

 

xyτ  
τ

xy,d

xy

f
 

 

Rτ  
R,d

R

f

τ
 

 

( )dint xyτ τ+
 

ττ τ τ β τ β+ = +
22

d
d2 2

v,d xy,d

,   cos sinxy
xz yz

f f
 

According to: 
ČSN 73 1702, (129) 
DIN 1052, (129) 
DIN EN 1995-1-1/NA, (NA.132) 

( )t/c,90 Rint σ τ+
 

t/c,90 R
t/c,90

t,90,d R,d

t/c,90 R
t/c,90

c,90,d R,d

if 0

if 0

f f

f f

σ τ
σ

σ τ
σ


+ >

= 
 + ≤


 

According to: 
ČSN 73 1702, (130), (131) 
DIN 1052, (130), (131) 
DIN EN 1995-1-1/NA, (NA.133), 
(NA.134) 

Table 5.3: Ratios for the orthotropic material model 



5  Results 

  

 49 Program RF-LAMINATE © 2013 Dlubal Software GmbH 

 

 

The stresses b+t/c,0 b+t/c,90 d R,  ,  ,  σ σ τ τ are defined in the coordinate system of the grain , ,x y z′ ′  
and the following transformation formulas apply 

2 2

T
3 3

2 2
b+t/c,0

d2 2
b+t/c,90

R2 2

2

2 ,    

*

x
xz

y
yz

xy

c s cs
c s

s c cs
s c

cs cs c s

σ σ
ττ

σ σ
ττ

τ
×

−
×

                = − =        −           
− −      T

T





 (5.2) 

or, equivalently, in the non-matrix form 

2 2
b+t/c,0

2 2
b+t/c,90

d

R

c s 2cs

s c 2cs

c s

s c

x y xy

x y xy

xz yz

xz yz

σ σ σ τ

σ σ σ τ

τ τ τ

τ τ τ

= + +

= + −

= +

= − +

 (5.3) 

where sin ,  coss cβ β= = and β is the rotation angle of the considered layer. 

Graph in Printout Report 

In the last column of the table, you can select the stress diagrams by thickness, displayed in the 
lower part of the window, that you want to import to the printout report of RF-LAMINATE, see 
Chapter 6.2.2, page 56. 

5.2 Max Stress/Ratio by Surface 

 

Figure 5.2: Window 2.2 Max Stress/Ratio by Surface 

This result window contains the maximum stresses/ratios for every designed surface. The data 
is listed according to individual surfaces. 

Individual table columns are described in Chapter 5.1 Max Stress/Ratio by Loading on page 45. 



5  Results 
 

 50 
 

Program RF-LAMINATE © 2013 Dlubal Software GmbH 

 

 

 

5.3 Stresses in All Points 

 

Figure 5.3: Window 2.3 Stresses in All Points 

In this window, the stresses and ratios are displayed in every FE mesh point, or in every grid 
point of the designed surfaces. In the Details dialog box, in the Results tab (see Chapter 4.1.1, 
page 42), you can set whether you want to display the results in FE mesh points or in grid 
points. 

In the Details dialog box, in the Stresses tab, you can also specify which stress components you 
want to display in the window. 

Individual table columns are described in Chapter 5.1 Max Stress/Ratio by Loading on page 45. 

If needed, you can filter the data in the table according to numbers of FE mesh points, num-
bers of surfaces, compositions or loadings. Selection is possible either from the lists under the 
table or you can select a certain point or surface in the graphical window by using the [Select] 
button. 
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5.4 Max Displacements 

 

Figure 5.4: Window 3.1 Max Displacements 

This window is displayed only if you have selected at least one load case for the design in Win-
dow 1.1 General Data, in the tab Serviceability Limit State (see Chapter 3.1.2, page 22). Here, the 
maximum values of displacements are shown from load cases, load combinations or result 
combinations that you selected for the serviceability limit state design. 

The data is listed according to individual surfaces. 

Displacements 
In the column Displacements, you can see the displacements in the direction of local axes z of 
given surfaces, which are governing for the deformation analysis. You can display the local ax-
es of the surfaces in the Display navigator in RFEM. 

In column I, the limit values of deformations are displayed. These values are determined from 
the reference lengths L, which are entered in Window 1.5 Serviceability Data, see page 32, and 
from the general limit values defined for the serviceability design in the Details dialog box, in 
the Design tab (Chapter 4.1.1, page 34). 

Ratio 
In the last column, ratios of the resulting displacement zu  (column G) and the limit displace-
ment (column H) are shown. If the limit deformations are not exceeded, the ratio is less than or 
equal to 1 and the deformation design is satisfied. 
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5.5 Parts List 

 

Figure 5.5: Window 4.1 Parts List 

The last result window shows the overall review of surfaces. The data refers only to designed 
surfaces by default. If you want to display the parts list of all surfaces in the structure, you can 
modify the setting in the Details dialog box, in the Results tab (Chapter 4.1.1, page 42). 

Surface No. 
This column contains the numbers of individual surfaces. 

Material Description 
Surfaces are classified according to materials. 

Thickness 
In column B, the thickness of layers t is displayed. The thicknesses can be also found in input 
Window 1.2 Material Characteristics. 

No. of Layers 
This column shows the number of layers in the structure that have the given material and 
thickness. 

Area 
Here, information about the area of every surface is displayed. 

Coating 
The total surface coating is calculated based on the upper and lower surface. Side surfaces are 
neglected. 

Volume 
The volume is calculated as the product of the thickness and surface area. 
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Weight 
In the last column, the weight of every surface is displayed. This entry is calculated based on 
the surface volume and the specific weight of the selected material. 

Total 
In the last table row, you can see the total sums of individual columns. 
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6.  Printout 
 

6.1 Printout Report 

As usual in RFEM, a printout report is created for the design results in RF-LAMINATE at first. You 
can insert graphical displays or your own comments to the printout report. In the printout re-
port, you can also select which RF-LAMINATE result windows you want to print. 

The printout report is described in detail in the RFEM manual. Chapter 10.1.3.4 Selecting Data 
of Add-on Modules is important in particular. This chapter describes the selection of input and 
output data in add-on modules. 

You can create several printout reports for each model. Especially in the case of complex struc-
tures, it is recommended to create a few smaller printout reports instead of one large report. If 
you create for example a separate printout report only for RF-LAMINATE data, the printout re-
port is processed  relatively fast. 

The stress components, which were selected for the display in result windows in RF-LAMINATE, 
appear in the printout report. 

6.2 Printing RF-LAMINATE Graphics 

6.2.1 Results on the Model in RFEM 
Graphical displays of the performed designs can be incorporated in the printout report or sent 
directly to a printer. In Chapter 10.2 Direct Graphic Printout in the RFEM manual, the printing of 
graphical displays is described in detail. 

Every image that is displayed in the graphical window in RFEM can be incorporated in the 
printout report. In the same way, you can take over result diagrams on sections to the printout 
report as well, by clicking the [Print] button in the respective window. 

You can print the current RF-LAMINATE graphical display in the RFEM work window by using 
the command from the main menu 

File → Print Graphic… 

or by clicking the relevant button in the toolbar. 

 

Figure 6.1: Button Print Graphic in the toolbar in the main window 

Then, the following dialog box appears. 
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Figure 6.2: Dialog box Graphic Printout - the General tab 

This dialog box is described in detail in Chapter 10.2 Direct Graphic Printout in the RFEM manu-
al. Other tabs Options, Color Spectrum and Factors are described there as well. 

You can move the RF-LAMINATE graphics to another place in the printout report, by using the 
drag & drop function. 

Inserted images can be also modified additionally: right-click the corresponding item in the 
printout report navigator and choose Properties... in the local menu. The dialog box Graphic 
Printout is displayed again, and you can set possible changes there. 

 

Figure 6.3: Dialog box Graphic Printout - the Options tab 
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6.2.2 Stress Diagrams 
In Windows 2.1, 2.2 and 2.3 of RF-LAMINATE, you can incorporate a selected picture to the 
printout report by using the check boxes in the column Graph in Printout Report. In figure 6.4, it 
is apparent that the stress diagram xyτ in point [0.5, 3.0, 0.0] will be displayed in the printout 
report. 

 

Figure 6.4: Window 2.1 Max Stress/Ratio by Loading 

The selected pictures are then displayed in the printout report in Chapter 4.2 Stress Diagrams. 

 

Figure 6.5: Stress diagrams in the printout report 
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7.  General Functions 
Commonly used functions from the main menu and export options for design results are de-
scribed in this chapter. 

 

7.1 Units and Decimal Places 

Units and decimal places for RFEM and all its add-on modules are set in one central dialog box. 
In RF-LAMINATE, you can open the dialog box for the setting of units by using the command 
from the main menu 

Settings → Units and Decimal Places…. 

The dialog box that is already familiar from RFEM opens. The RF-LAMINATE module is already 
preset in this dialog box. 

In figure 7.1, you can see that some units are marked with a red arrow (the thicknesses and ma-
terial characteristics in this case). This marking is used for a quick orientation in the dialog box 
Units and Decimal Places, for the currently opened RF-LAMINATE window. In this case, Window 
1.2 Material Characteristics is opened in the module, therefore it is very easy to find and then 
change the units related to this window. 

 

Figure 7.1: Dialog box Units and Decimal Places 

You can save the settings as a user-defined profile and then use it in other models. You can 
find the description of this function in Chapter 11.1.3 Units and Decimal Places in the RFEM 
manual. 
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7.2 Export of Results 

You can also transfer the analysis results to other programs in a variety of ways. 

Clipboard 
You can copy the marked rows in the RF-LAMINATE result window to the Clipboard by using 
the buttons [Ctrl]+[C] and then transfer for example to a text processor by using [Ctrl]+[V]. The 
headings of table columns are not exported. 

Printout report 
RF-LAMINATE data can be incorporated in the central printout report (Chapter 6.1, page 54) 
and then exported by using the command from the main menu 

File → Export to RTF…. 

This function is described in Chapter 10.1.11 Export Printout Report in the RFEM manual. 

Excel / OpenOffice 
RF-LAMINATE provides a direct export of data to MS Excel or to the Calc application from the 
OpenOffice.org package. 

You call up this function from the main menu of RF-LAMINATE 

File → Export Tables…. 

The following dialog box for the data export opens: 

 

Figure 7.2: Dialog box Export - MS Excel 

As soon as you select the required parameters, you can start the export by clicking the [OK] 
button. Excel or Calc need not run in the background, it is automatically started before the ex-
port. 
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Figure 7.3: Results in MS Excel: Table 2.1 Max Stress/Ratio by Loading 

 

7.3 Keyboard Shortcuts 
In individual windows and dialog boxes of RF-LAMINATE, you can call up frequently used func-
tions from the keyboard quickly: 

[F1] Help 

[F2] Next Window 

[F3] Previous Window 

[F7] Selection in Tables 

[F8] Copy the Last Table Row 

[F9] Calculator 

[Ctrl+2] Copy a Table Row to Next Row 

[Ctrl+C] Copy to the Clipboard 

[Ctrl+F] Find in the Table 

[Ctrl+H] Find and Replace in the Table 

[Ctrl+I] Insert a Row in the Table 

[Ctrl+L] Go to Row with a Given Number 

[Ctrl+R] Delete Table Rows 

[Ctrl+S] Save Data 

[Ctrl+V] Insert Data from the Clipboard 

[Ctrl+X] Exclude from Table 

[Ctrl+Y] Empty the Current Table Row 

[Ctrl+Z] Undo 

Table 7.1: Keyboard shortcuts 
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8.  Examples 
Several examples are introduced in the following chapter. 

8.1 Calculation of Stiffness Matrix Elements 

Consider a plate consisting of three layers that are shown in figure 8.1 and their material char-
acteristics are displayed in figure 8.2. 

 

  

 Layer No. 1 

 Layer No. 2 

 Layer No. 3 

  

Figure 8.1: Layer scheme 

 

Figure 8.2: Table 1.2 Material Characteristics 

At first, you calculate the stiffness matrices of individual layers 
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Figure 8.3: Stiffness matrix of Layer No. 1 from RF-LAMINATE 

2 2

2
2

2

7000 0.2 230
0

230 270
1 0.2 1 0.2

7000 7000 7009.21 46.06 0
270

0 46.06 230.30 0 MN/m
230

1 0.2 0 0 440.007000
sym. 440

⋅ 
 
− − 

   
   ′ = =   
 −    
 
 
 

d  

 

Figure 8.4: Stiffness matrix of Layer No. 2 from RF-LAMINATE 

2 2

2
3

2

8000 0.2 270
0

270 270
1 0.2 1 0.2

8000 8000 8010.81 54.07 0
270

0 54.07 270.36 0 MN/m
270

1 0.2 0 0 500.008000
sym. 500

⋅ 
 
− − 

   
   ′ = =   
 −    
 
 
 

d  

 

Figure 8.5: Stiffness matrix of Layer No. 3 from RF-LAMINATE 

Now, you have to rotate the layers to the same coordinate system ,x y  (local coordinate sys-

tem of the surface). Layers No. 1 and 3 have the orthotropy direction 0 ,β = °  therefore it ap-
plies that 

2
1 1

8010.81 54.07 0

54.07 270.36 0 MN/m

0 0 500.00

 
 ′= =  
  

d d  

2
3 3

8010.81 54.07 0

54.07 270.36 0 MN/m

0 0 500.00

 
 ′= =  
  

d d  
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Because Layer No. 2 is rotated by the angle 90β = ° , it is necessary to transform the stiffness 
matrix of Layer No. 2 to the coordinate system , .x y  

;11 ;12 ;13
T

;22 ;23 3×3; 3×3;

;33sym.

i i i

i i i i i i

i

d d d

d d

d

 
  ′= = 
  

d T d T  (8.2) 

where 

2 2

2 2
3×3;

2 22 2

i

c s cs

s c cs

cs cs c s

 
 
 = −
 
− −  

T , where ( ) ( )cos , sini ic sβ β= =  (8.3) 

The individual elements then are 

4 2 2 4 2 2
;11 ;11 ;12 ;22 ;332 4i i i i id c d c s d s d c s d′ ′ ′ ′= + + +

2 2 4 4 2 2 2 2
;12 ;11 ;12 ;12 ;22 ;334i i i i i id c s d s d c d c s d c s d′ ′ ′ ′ ′= + + + −

3 3 3 3 3 3
;13 ;11 ;12 ;12 ;22 ;33 ;332 2i i i i i i id c sd cs d c sd cs d c sd cs d′ ′ ′ ′ ′ ′= + − − − +
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3 3 3 3 3 3
;23 ;11 ;12 ;12 ;22 ;33 ;332 2i i i i i i id cs d c sd cs d c sd c sd cs d′ ′ ′ ′ ′ ′= + − − + −

( )22 2 2 2 2 2 2 2
;33 ;11 ;12 ;22 ;332i i i i id c s d c s d c s d c s d′ ′ ′ ′= − + + −  

 
cos90 0, sin90 1c s= ° = = ° =  

4 2 2 4 2 2 2
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=
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3 3 3 3 3 3
2;23

2

0 1 7009.21 0 1 46.06 0 1 46.06 0 1 230.30 2 0 1 440 2 0 1 440

0 MN/m

d = ⋅ ⋅ + ⋅ ⋅ − ⋅ ⋅ − ⋅ ⋅ + ⋅ ⋅ ⋅ − ⋅ ⋅ ⋅ =
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( )22 2 2 2 2 2 2 2 2
2;33 0 1 7009.21 2 0 1 46.06 0 1 230.30 0 1 440 440.00 MN/md = ⋅ ⋅ − ⋅ ⋅ ⋅ + ⋅ ⋅ + − =  

 
The total planar stiffness matrix of Layer No. 2 is then 

2
2

230.30 46.06 0

46.06 7009.21 0 MN/m

0 0 440.00

 
 =  
  

d  

 

 

Figure 8.6: Stiffness matrix of layer No. 2 from RF-LAMINATE 
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8.1.1 Shear Coupling of Layers Is Considered 
The global stiffness matrix has the form 
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Stiffness matrix elements (bending and torsion) 
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Stiffness matrix elements (eccentricity effects) 
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Stiffness matrix elements (membrane) 
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Stiffness matrix elements (shear) 

As already mentioned in Chapter 2.3, the calculation procedure for shear elements of the stiff-
ness matrix is not introduced. However, it can be verified that the following relation applies 
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The individual elements then are 

2 2
;11 ; ;i i xz i yzG c G s G= +  

;12 ; ;i i xz i yzG csG csG= −  

2 2
;22 ; ;i i xz i yzG s G c G= + , where ( )cos ic β= , ( )sin is β=  

The shear stiffness matrix elements adapted from RF-LAMINATE are the following 
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2 2
2;11 0 440 1 44 44 MPaG = ⋅ + ⋅ =  
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2
44 0

0 440
 

=  
 

G  

 

( )44
5 5 5 5

max 500 10; 44 16; 500 12 max 500; 44;500 (10 16 12)
6 6 6 6

D ⋅ ⋅ ⋅ ≤ ≤ ⋅ + + 
 

 

5000 5000 15833≤ ≤  
 

( )55
5 5 5 5

max 50 10; 440 16; 50 12 max 50; 440;59 (10 16 12)
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D ⋅ ⋅ ⋅ ≤ ≤ ⋅ + + 
 

 

5866.67 5866.67 13933.33≤ ≤  
 
Global stiffness matrix 
 

33.85 0.24 0 0 0 124.49 0.13 0

3.64 0 0 0 0.13 107.82 0

2.26 0 0 0 0 0.96

5000.00 0 0 0 0

5866.67 0 0 0
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Figure 8.7: Dialog box Extended Stiffness Matrix Elements from RF-LAMINATE – with shear coupling of layers 
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8.1.2 Shear Coupling of Layers Is Not Considered 
Because angles iβ  are multiples of 90° , the global stiffness matrix has the form 

11 12

22

33

44

55

66 67

77

88

0 0 0 0 0 0

0 0 0 0 0 0

0 0 0 0 0

0 0 0 0

0 0 0

sym. 0

0

D D

D

D

D

D

D D

D

D

 
 
 
 
 
 =  
 
 
 
 
  

D  (8.9) 

 

 

 

Stiffness matrix elements (bending and torsion) 

3

11 ;11
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= ∑  

3
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i
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112
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i

i
i

t
D d

=
= ∑  

 
3

33 ;33
112

n
i

i
i

t
D d

=
= ∑  

 

2
1

8010.81 54.07 0

54.07 270.36 0 MN/m

0 0 500.00

 
 =  
  

d  

2
2

230.30 46.06 0

46.06 7009.21 0 MN/m

0 0 440.00

 
 =  
  

d  

2
3

8010.81 54.07 0

54.07 270.36 0 MN/m

0 0 500.00

 
 =  
  

d  

3 3 3
3 3 3
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0.010 0.016 0.012

8010.81 10 230.30 10 8010.81 10 1.900 kNm
12 12 12

D = ⋅ + ⋅ + ⋅ =  

3 3 3
3 3 3

12
0.010 0.016 0.012
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12 12 12

D = ⋅ + ⋅ + ⋅ =  

3 3 3
3 3 3
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0.010 0.016 0.012
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D = ⋅ + ⋅ + ⋅ =  

3 3 3
3 3 3
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500 10 440.00 10 500 10 0.264 kNm
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Stiffness matrix elements (membrane) 

66 ;11
1

n

i i
i

D t d
=

= ∑  67 ;12
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i i
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D t d
=

= ∑  
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D t d
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3 3 3 3 3 3
66 10 10 8010.81 10 16 10 230.30 10 12 10 8010.81 10 179923 N/mD − − −= ⋅ ⋅ ⋅ + ⋅ ⋅ ⋅ + ⋅ ⋅ ⋅ =  

3 3 3 3 3 3
67 10 10 54.07 10 16 10 46.06 10 12 10 54.07 10 1927 N/mD − − −= ⋅ ⋅ ⋅ + ⋅ ⋅ ⋅ + ⋅ ⋅ ⋅ =  

3 3 3 3 3 3
77 10 10 270.36 10 16 10 7009.21 10 12 10 270.36 10 118095 N/mD − − −= ⋅ ⋅ ⋅ + ⋅ ⋅ ⋅ + ⋅ ⋅ ⋅ =  

3 3 3 3 3 3
88 10 10 500 10 16 10 440 10 12 10 500 10 18040 N/mD − − −= ⋅ ⋅ ⋅ + ⋅ ⋅ ⋅ + ⋅ ⋅ ⋅ =  

 
Stiffness matrix elements (shear) 
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The individual elements then are 
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Global stiffness matrix 
 

1.900 0.028 0 0 0 0 0 0

2.454 0 0 0 0 0 0

0.264 0 0 0 0 0

9753 0 0 0 0

6783 0 0 0

sym. 179923 1927 0

118095 0

18040

 
 
 
 
 
 =  
 
 
 
 
  

D  

 

 

Figure 8.8: Dialog box Extended Stiffness Matrix Elements from RF-LAMINATE – without shear coupling of layers 
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8.2 Calculation of Stresses 
Consider a plate from the previous example, consisting of three layers with material character-
istics displayed in figure 8.10. 

 

  

 Layer No. 1 

 Layer No. 2 

 Layer No. 3 

  

Figure 8.9: Layer scheme 

 

Figure 8.10: Table 1.2 Material Characteristics 

In the previous example from Chapter 8.1, the calculation of stiffness matrix elements is pre-
sented for the case of the shear coupling of layers and also for the case without the shear cou-
pling of layers. Now, the calculation of stresses is carried out. 

The plate with the dimensions 1.0 x 1.5 m is simply supported and loaded with a surface load 
of 5 kN/m2. 

8.2.1 Calculation of Individual Stress Components 
By using the finite element method in RFEM, you get the stresses , , , , .x y xy xz yzσ σ τ τ τ  The 
stress values in the point with coordinates [0.8, 0.8, 0], in the middle layer, are shown in the fol-
lowing pictures. In the first case it is the structure where the shear coupling of layers is consid-
ered, in the second case the shear coupling of layers is not considered. 

 

Figure 8.11: Window 2.3 Stresses in All Points – the example with the shear coupling of layers 
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Figure 8.12: Window 2.3 Stresses in All Points – the example without the shear coupling of layers 

Because the calculation of individual stress components for both cases is the same, only the 
case with the shear coupling of layers is presented here, therefore with the following values. 

Point Side xσ  [kPa] yσ  [kPa] xyτ  [kPa] 

x = 0.8 m, 
y = 0.8 m, 

Layer No. 2 

top -27.47 -128.75 3.44 
middle -4.70 -5.05 0.35 
bottom 18.07 118.65 -2.75 

Table 8.1: Stresses in Layer No. 2 in point [0.8;0.8] 

The middle layer is rotated of the angle 90β = °  

2 2
b+t/c,0 cos sin2 sinx xy yσ σ β τ β σ β= + +  

( )2 2
b+t/c,0(top) 27.47cos 90 3.44 sin 2 90 128.75sin 90 128.75 kPaσ = − °+ ⋅ ⋅ ° − ° = −  

( )2 2
b+t/c,0(middle) 4.70cos 90 0.35 sin 2 90 5.05sin 90 5.05 kPaσ = − °+ ⋅ ⋅ ° − ° = −  

( )2 2
b+t/c,0(bottom) 18.07cos 90 2.75 sin 2 90 118.65sin 90 118.65 kPaσ = °− ⋅ ⋅ ° + ° =  

 
2 2

b+t/c,90 sin sin2 cosx xy yσ σ β τ β σ β= − +  

( )2 2
b+t/c,90(top) 27.47sin 90 3.44 sin 2 90 128.75cos 90 27.47 kPaσ = − °− ⋅ ° − ° = −  

( )2 2
b+t/c,90(middle) 4.70sin 90 0.35sin 2 90 5.05cos 90 4.70 kPaσ = − °− ⋅ ° − ° = −  

( )2 2
b+t/c,90(bottom) 18.07sin 90 ( 2.75)sin 2 90 118.65cos 90 18.07 kPaσ = °− − ⋅ ° + ° =  

 

b+t/c,0(top) b+t/c,0(middle) b+t/c,0(bottom)
t/c,0 3

σ σ σ
σ

+ +
=  

σ − − +
= = −t/c,0

128.75 5.05 118.65
5.05 kPa

3
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b+t/c,90(top) b+t/c,90(middle) b+t/c,90(bottom)
t/c,90 3

σ σ σ
σ

+ +
=  

σ − − +
= = −t/c,90

27.47 4.70 18.07
4.70 kPa

3
 

 

b,0 b+t/c,0 t/c,0σ σ σ= −  

b,0(top) 128.75 ( 5.05) 123.70 kPaσ = − − − = −  

b,0(middle) 5.05 ( 5.05) 0 kPaσ = − − − =  

b,0(bottom) 118.65 ( 5.05) 123.70 kPaσ = − − =  

 

b,90 b+t/c,90 t/c,90σ σ σ= −  

b,90(top) 27.47 ( 4.70) 22.77 kPaσ = − − − = −  

b,90(middle) 4.70 ( 4.70) 0 kPaσ = − − − =  

b,90(bottom) 18.07 ( 4.70) 22.77 kPaσ = − − =  

 

8.2.2 Calculation Procedure in RF-LAMINATE 
First, you need to create a New Model in RFEM. 

 

Figure 8.13: Creating a new model 
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After entering a new model, create a New Surface. Choose Laminate as the surface type and  
define the plate dimensions as 1.0 x 1.5 m. 

 

Figure 8.14: Dialog box New Rectangular Surface 

Define the surfaces according to figure 8.15. 

 

Figure 8.15: Table Line Supports 

Now create a New Load Case. 
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Figure 8.16: Dialog box Edit Load Cases and Combinations - the tab Load Cases 

Next, fill in the dialog box New Surface Load. 

 

Figure 8.17: Dialog box New Surface Load 
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In the dialog box FE Mesh Settings, set the length of finite elements to 25 mm. 

 

Figure 8.18: Dialog box FE Mesh Settings 

Now you can open the RF-LAMINATE module and fill in the individual input windows. 

 

Figure 8.19: Navigator Data: Add-on Modules → RF-LAMINATE 
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In Window 1.1 General Data, select Surface No. 1. Then select the orthotropic material model 
and select LC1 for the design. 

 

Figure 8.20: Window 1.1 General Data 

In Window 1.2 Material Characteristics, select individual layers from the material library and as-
sign the created composition to Surface No. 1. 

 

Figure 8.21: Window 1.2 Material Characteristics 
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In following the next window, 1.3 Material Strengths, characteristic strength values are import-
ed from the material library automatically. 

 

Figure 8.22: Window 1.3 Material Strengths 

In the last input window, enter Surface No. 1 to the List of Surfaces. Because the Manual check 
box is not selected, the Reference Length L is completed automatically. 

 

Figure 8.23: Window 1.5 Serviceability Data 
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Then, check the settings in the Details dialog box and start the calculation. 

 

Figure 8.24: Dialog box Details – the Stresses tab 

 

Figure 8.25: Dialog box FE-Calculation… 
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You can check the stress values in result windows and make sure that they match the calcula-
tion introduced in the previous chapter. 

 

Figure 8.26: Window 2.3 Stresses in All Points 
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9.  Annexes 
 

9.1 Transformation Relations 

The relations necessary for the transformation of stresses, strains and stiffness matrices at the 
rotation of the coordinate system , ,x y z to the coordinate system , ,x y z′ ′  of angle β  are 
summarized here. Angle β  is defined as 

 

 

The quantities related to the system , ,x y z , such as stresses, strains and elements of stiffness 
matrices, are marked without an acute accent ( ´), the quantities in the system , ,x y z′ ′  are 
marked with an acute accent. The transformation relations for plane stresses and strains are 
the following 

T
3×3

2 2

b+t/c,02 2

b+t/c,902 2

2

2 ,   
x x

x
y y

y
xy xy

c s cs

s c cs

cs cs c s

σ σ
σσ

σ σ
σσ

τ τ

−

    ′   ′       ′  = − ≡       ′         ′ − −     
T



 (9.1) 

3×3

2 2

2 2

2 22 2

x x

y y

xy xy

c s cs

s c cs

cs cs c s

ε ε
ε ε
γ γ

    ′     ′  = −   
    ′ − −     

T



 (9.2) 

The stiffness matrix is transformed according to the relation 

T T 1
2×2 2×2 2×2 2×2      − −′ ′= ⇔ =d T d T d T dT  (9.3) 

11 12 13 11 12

22 23 22

33 33

0

,    0

sym. sym.

d d d d d

d d d

d d

′ ′   
   ′ ′= =   
   ′   

d d  (9.4) 

The transformation relations for shear stresses and strains are the following 

2×2

R
,    

xz xz xzd

yz yz yz

c s

s c

τ τ ττ
τ τ ττ

′ ′             = ≡        ′ ′−             
T



 (9.5) 

2×2

xz xz

yz yz

c s

s c

γ γ
γ γ
′       =    ′ −       

T


  (9.6) 

The stiffness matrix is transformed according to the relation 

T T
2×2 2×2 2×2 2×2      ′ ′= ⇔ =G T G T G T GT  (9.7) 

11 12 11

22 22

0
,    

sym. 0

G G G

G G

′   ′= =   ′   
G G  (9.8) 
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9.2 Checking the Positive Definiteness of the 
Stiffness Matrix 

The positive definiteness of the global stiffness matrix in necessary for calculation. 

Generally, the global stiffness matrix has the shape 

× ×

× ×

× ×

 
 = = 
  
 
 
 
 
 
 =  
 
 
 
 
  

bending eccentric
3 3 3 3

shear
8 8 2 2

eccentric membrane
3 3 3 3

11 12 13 16 17 18

22 23 27 28

33 38

44 45

55

66 67 68

77 78

88

sym.

sym. sym.

sym.

D D D D D D

D D D D

D D

D D

D

D D D

D D

D

D 0 D

D 0 D 0

D 0 D

 (9.9) 

The following conditions are checked: 

1. Matrix D  is positive-definite (that is all of its leading principal minors are positive). 

2. In addition, it is required that the submatrices bending shear membrane
3 3 2 2 3 3,  ,  × × ×D D D are positive-

definite in a more restrictive sense – all of its leading principal minors must satisfy: 

11

1

det 0.001 ,     pro   1, ,ii
i

ii

D

D i n

D =

 
  ≥ = 
  

∏   (9.10)
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